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Copyright 2003 © Impatica Inc.  All rights reserved. 

Impatica for PowerPoint User’s Manual. 

The contents of this manual and associated Impatica for PowerPoint software are the 
property of Impatica Inc. and are copyrighted.   

All specifications, claims, features, representations and/or comparisons provided are 
correct to the best knowledge of Impatica as of the date of publication, but are subject to 
change without notice. 

INFORMATION IS PROVIDED BY IMPATICA ON AN “AS IS “ BASIS, WITHOUT 
ANY OTHER WARRANTIES OR CONDITIONS, EXPRESSED OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABLE 
QUALITY, SATISFACTORY QUALITY, MERCHANTIBILITY OR FITNESS FOR A 
PARTICULAR PURPOSE.  IN NO EVENT SHALL IMPATICA INC. BE LIABLE 
FOR ANY LOSS OF REVENUE OR PROFIT OR ANY OTHER COMMERCIAL 
DAMAGE, INCLUDING BUT NOT LIMITED TO SPECIAL, INCIDENTAL, 
CONSEQUENTIAL OR OTHER DAMAGES.  WE ARE ALSO NOT RESPONSIBLE 
FOR THE CLAIMS BY A THIRD PARTY.  OUR MAXIMUM AGGREGATE 
LIABILITY SHALL NOT EXCEED THIRTY DOLLARS CANADIAN ($30 CDN). 

PowerPoint, Windows 95/98/NT/Me/2000/XP and Outlook are trademarks of Microsoft 
Corporation. 
Java is a trademark of Sun Microsystems. 
Netscape is a trademark of Netscape Communications Corporation. 
The Java Impatica for PowerPoint runtime is distributed in Eastridge Technology's 
Jshrink format. 
This software is based in part on the work of the Independent JPEG Group. 
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1111    IntroductionIntroductionIntroductionIntroduction    
Welcome to the wonderful world of plug-in free interactive rich streaming media. 

This User’s Manual explains everything you need to know about using Impatica for 
PowerPoint to transform existing or newly developed Microsoft PowerPoint™ 
presentations for delivery over the Internet without plug-ins and at low bandwidth.  
It is not intended to teach you how to use PowerPoint.  We presume that you already 
have an adequate knowledge in that area.   

Here is what it does cover: 

• what Impatica for PowerPoint is, how to install it, how to run it, how it works 
and how to publish your content to the web or deliver it through e-mail; 

• a collection of tips and tricks that we have found helpful for using Impatica for 
PowerPoint to convert PowerPoint presentations for web delivery; 

• a list of PowerPoint features that are supported by Impatica for PowerPoint, and 
those that are not.  In some cases, we even provide suggestions for working 
around the unsupported PowerPoint features; and 

• some special guidance on using narration within your PowerPoint presentation. 
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2222    What is IWhat is IWhat is IWhat is Impatica for PowerPoint?mpatica for PowerPoint?mpatica for PowerPoint?mpatica for PowerPoint?    
Impatica for PowerPoint is a software tool that allows Microsoft PowerPoint 
presentations to be played over the Internet or corporate intranets without plug-ins, 
at modem speeds as low as 28.8 kbps.  More specifically, Impatica for PowerPoint 
is a standalone translator program, which runs on Windows 98/NT/2000/Me/XP*.  
Impatica for PowerPoint reads and interprets the PowerPoint file and produces a 
compressed file that can be streamed over the Internet.   

Impatica for PowerPoint extracts the various multimedia elements (text, graphic, 
audio, video, animation and interactivity) and their attributes and, where possible, 
converts them into a more efficient format for web delivery.    

 

The new “Impatica” file (with the extension “.imp”) can then be read by Impatica's 
Java player applet (“ImPlayer”) and played in real time while the file is streaming 
over the Internet. 

Once you have created the Impatica for PowerPoint version of your presentation, it 
can be played from any HTML web page or from within an e-mail message.  No 
special server side software is required. 

*  Caution To ensure faithful rendering of text fonts, the conversion process 
should be run on the same computer on which the PowerPoint 
presentation was created or, at least, should have all fonts that are 
used in the presentation installed on the system on which the 
conversion is being done. 
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3333    Downloading Impatica for PowerPointDownloading Impatica for PowerPointDownloading Impatica for PowerPointDownloading Impatica for PowerPoint    
Impatica for PowerPoint can be downloaded from the Impatica Web site and used 
either as a licensed copy or an Evaluation copy.  Go to the Evaluation page of the 
Impatica Web site or simply follow this link: 

http://www.impatica.com/evaluation/  

 

Please complete the information form provided.  Rest assured that the information 
you provide will be kept confidential and will not be provided to third parties.  Here 
is a portion of that form. 

http://www.impatica.com/evaluation/
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Although you can download and install Impatica for PowerPoint, you will need a 
Registration Code to activate the software as either an Evaluation or Licensed copy.   

Once you have completed and submitted the form (with all of the required fields 
filled in), a page will display showing your Registration information (including 
Registration Code) for your evaluation copy of Impatica for PowerPoint.  It is 
recommended that you save or print the information on this page. 
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The Registration Code for the licensed copy will be provided to you by Impatica 
Customer Support as soon as your purchase has been processed. 

Click on the link to continue downloading Impatica for PowerPoint. 
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Review the download instructions and click on the link for the product and version 
you desire to begin the download process.   



Impatica for PowerPoint User’s Manual  

Version 2.5.1  Page 7 

You will be prompted to specify the location to which the software should be 
downloaded.  You must remember this location so that you can install the software 
once it has been downloaded.  The download file is called “setupppt.exe” for 
Impatica for PowerPoint. 

 

Once you have downloaded your copy of Impatica for PowerPoint, you need to 
install it on your computer. 
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4444    Installing Impatica for PowerPointInstalling Impatica for PowerPointInstalling Impatica for PowerPointInstalling Impatica for PowerPoint    
Note:  It will be necessary to uninstall any previous version of Impatica for 
PowerPoint before attempting to install this version of the software (see Section 5 
- Uninstalling Impatica for PowerPoint). 

4.1 Launching the Installer  

4.1.1 From a Download 
The file “setupppt.exe” is a standard install package.  Simply 
double click on the file icon to begin the install process.  

4.1.2 From a CD-ROM 
Open the folder “Impatica for PowerPoint”.  Double-click on the 
file “setupppt.exe”. 

4.2 Using the Installer 
To begin the installation, click Next on the first screen of the Setup Wizard. 

 

You will then be presented with the Software License Agreement for 
Impatica for PowerPoint.  You must select the “I accept the terms in the 
license agreement” option and click Next in order to proceed with 
installation. 
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You will then be prompted for a directory in which to install the files.  The 
default directory is C:\Program Files\Impatica for PowerPoint.  If you 
wish to change the destination directory, click the Change button and select 
a different destination folder (otherwise click the Next button). 

 



Impatica for PowerPoint User’s Manual  

Version 2.5.1  Page 10 

Once you are confident that you have specified the correct settings, click the 
Install button to proceed with the installation.  If you need to modify any of 
your settings, click the Back button to return to the appropriate screen. 

 

Impatica for PowerPoint will now begin to install on your machine.  To 
halt this process, press the Cancel button. 
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When the setup is complete, the following dialog box will appear: 

 

Here, you can choose to launch Impatica for PowerPoint and to see the 
Readme file. To complete the process, click Finish. 
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5555    Uninstalling Impatica for PowerPointUninstalling Impatica for PowerPointUninstalling Impatica for PowerPointUninstalling Impatica for PowerPoint    
To uninstall Impatica for PowerPoint, from the Start menu, choose Settings and 
then Control Panel.  From the Control Panel, double click on Add/Remove 
Programs.  In the Add/Remove Programs dialog box, select “Impatica for 
PowerPoint” from the list of “Currently Installed Programs”.  Then click Remove. 
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6666    Using Impatica for PowerPointUsing Impatica for PowerPointUsing Impatica for PowerPointUsing Impatica for PowerPoint    
Impatica for PowerPoint is a software program that reads “.ppt” files that were 
created using Microsoft PowerPoint* and translates them into a compressed and 
web-friendly format.   

Once translated, the Impatica for PowerPoint presentations can be embedded into 
web pages for efficient and plug-in free delivery over the Internet or corporate 
intranets.  Impatica for PowerPoint presentations can also be sent as e-mail 
messages to specific recipients.   

Once you have installed Impatica for PowerPoint on your Windows computer, you 
are ready to translate PowerPoint presentations for Internet delivery. 

 

* Caution: Both PowerPoint 97, PowerPoint 2000, and PowerPoint 2002 
(“XP”) files are supported.  However, presentations saved as 
“PowerPoint 97-2000 & 95 presentation” are NOT supported. 

Furthermore, PowerPoint 98 and 2001 for Macintosh files are not 
supported. 
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6.1 Running Impatica for PowerPoint  
To translate a PowerPoint presentation, launch Impatica for PowerPoint 
from your Start Menu or desktop icon.   

 

Alternatively, you can drag and drop one or more “.ppt” files onto the 
Impatica for PowerPoint desktop icon to invoke the translator.   
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6.2 Registering Your Copy of Impatica for PowerPoint 
Each copy of Impatica for PowerPoint must be registered as either an 
Evaluation copy or licensed copy before it can be used.  Copies that were 
previously registered as Evaluation copies can be re-registered as licensed 
copies without re-installation. 

To register your copy of Impatica for PowerPoint, click on the 
Registration Code… button. 
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The following dialog box will appear.  It is important that you enter your 
Name, Organization and Registration code exactly as they were provided to 
you, including spaces and case sensitivity. 

 

6.3 Selecting the Source Content Files for Translation 
When you invoke Impatica for PowerPoint using the drag and drop 
technique, the Source Files panel will appear, listing the files that had been 
dropped onto the program icon. 

 

You can add more .ppt files to the list as often as you wish.  Simply drag the 
file onto the Source Files List in the Impatica for PowerPoint window.  
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You can also click the Add button and an Open dialog box will appear.  To 
remove .ppt files from the Source PowerPoint Files list, simply select the 
desired file and click the Remove button. 
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6.4 Translation Options 
In addition to selecting all of the files you wish to translate, there are a 
number of translation options you can select; these options are grouped and 
presented on two tabs:  Slide Show and Media and Animations.   These 
settings can be selected individually for each file being translated.  Simply 
select the file from the source file list and set the appropriate options. 

 

Each tab includes buttons labeled Apply to All and Save as Default.  Click 
the Apply to All button to apply the settings on the current tab to all files 
being translated (all files displayed in the files list).  To create default 
settings, click the Save as Default button. Once saved as the defaults, the 
settings on the current tab will be applied to any additional files added to this 
batch of source files and will be the default settings for this tab when you run 
Impatica for PowerPoint in the future. 
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6.4.1 Slide Show 
The Slide Show tab houses general options that pertain to the 
overall presentation, and to the function of the translator. 

 

 

6.4.1.1 Save Location 
Impatica for PowerPoint allows you to specify the 
location on your hard drive in which the resulting Impatica 
file will be saved. 

By default, Impatica for PowerPoint will save the 
translated file in the same folder as the source file.  To 
change the save location for a file, select the file in the 
Source PowerPoint Files list box, then click the Browse 
button. 

To save the translated file in the same location as its source 
file, click the Source Folder button. 



Impatica for PowerPoint User’s Manual  

Version 2.5.1  Page 20 

  

Caution: Impatica for PowerPoint does not prompt when 
overwriting an existing .imp file (.imp is the extension 
used to identify Impatica files), unless you specify the 
save location by clicking the “Browse..” button. 

 

6.4.1.2 Include Playback Controls 
Selecting this option causes Impatica for PowerPoint to 
include a console that will allow the viewer to control 
playback.  The controls consist of VCR-like buttons that 
allow the user to (from left to right on the console):  rewind 
the presentation (move to the first slide), move to the 
previous slide, pause/play the presentation, and move to the 
next slide.  There is also a mute button on the far right side 
of the console. 
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If this option is selected, you will be permitted to choose 
the Foreground and Background colors for the console.  
A preview of the console layout and color scheme is shown 
in the Playback Controls panel, as well as in the color 
selection window that appears when selecting foreground 
and background colors. 

You may select from the preset colors on the Swatches tab, 
or tailor your colors by modifying the values on the HSB 
(Hue, Saturation, Brightness) and RGB (Red, Green, Blue) 
tabs. 
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6.4.1.3 Loading Color 
During playback, while the Impatica player applet is 
loading the first segment of the presentation, a loading 
indicator will be shown in the presentation area.  The 
loading indicator consists of two parts, as shown below:  a 
colored background (1), and a spinning “pinwheel” (2). 

 

The Loading Color button allows you to select the color of 
the colored background (1) portion of the loading indicator.  
The spinning “pinwheel” (2) will be automatically set to a 

1 

2
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color that is complementary to that chosen using the 
Loading Color selector. 

The color selector panel is similar to the one presented for 
selecting the Foreground and Background colors for the 
Playback Controls (see Section 6.4.1.2 Include Playback 
Controls). 

 

6.4.1.4 Export Notes To HTML 
When this option is selected, Impatica For PowerPoint 
will extract text from the Notes section of the PowerPoint 
presentation, and present this text formatted in an HTML 
page. The HTML file will be saved in the same folder as 
the corresponding Impatica (“.imp”) file. 

After translation, using the “Put Other” functionality in the 
web server upload tab (see Section 6.9.5 Uploading Files), 
this HTML file can be uploaded onto your FTP server, and 
offered to your audience as an alternative way to convey 
the key points of your presentation in a convenient and 
easily viewed format that is also accessible to screen 
readers. 

 

6.4.1.5 Export Notes To Plain Text  
Much like the Export Notes To HTML option, selecting 
this option saves the extracted text from the Notes section 
of the PowerPoint presentation as a plain-text (.txt) file. 
The text file will be saved in the same folder as the 
corresponding Impatica (“.imp”) file. 

This extracted text can now easily be entered into other 
applications, or uploaded to your FTP server using “Put 
Other” (see Section 6.9.5 Uploading Files) as an alternate 
format for distributing the information contained in your 
presentation. 

 

6.4.1.6 Export Notes to OnCue Script File 
If this option is selected, Impatica for PowerPoint will 
extract text from the Notes section of your source 
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PowerPoint file, and generate a tagged Impatica script file, 
for use in Impatica OnCue (visit www.impatica.com for 
more information on Impatica OnCue).   

The Impatica script file will contain the Notes text, with 
tags inserted to denote slides and paragraphs, as extracted 
from the PowerPoint file.  The first slide and all title slides  
will be set to top-level sections in the script file, while other 
slides will become subsections.  These section markings in 
the script file will be used for synchronization of the 
Impatica OnCue presentation, and will be used to build a 
menu for navigation within the OnCue presentation (refer 
to the Impatica OnCue User’s Manual for further 
information).  If there is no text in the Notes, a skeleton 
script file is generated so that the synchronization can be 
maintained, but no text will appear in the scrolling text 
during the OnCue presentation playback. 

The Include paragraph cue points checkbox is only 
enabled for selection if you have checked the Generate 
script file box.  Checking Include paragraph cue points 
instructs Impatica for PowerPoint to include 
synchronization tags for every paragraph in the script file 
(as extracted from the Notes portion of the source 
PowerPoint file).  If the box is left unchecked (but the 
Generate script file box is checked), there will be no 
synchronization tags included with the paragraph tags in 
the generated script file.  If you wish to mark some (but not 
all) paragraphs with synchronization tags, leave this box 
unchecked, and edit the generated script file manually to 
insert your synchronization tags.  See the Impatica OnCue 
User’s Manual for further information on using and 
editing Impatica script files. 

 

6.4.1.7 Generate HTML File 
Selecting the Generate HTML Option will cause 
Impatica for PowerPoint to create an HTML document 
that can be used to preview the translated file that was 
saved on your local drive.  The HTML file will be saved in 
the same folder as the corresponding Impatica (“.imp”) 
file. 

 

http://www.impatica.com/
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6.4.1.8 Make Hyperlinks Open New Window 
If this option is selected, all hyperlinks to URL will open a 
new browser window and display the desired page within 
the new window. Otherwise, the target URL will appear in 
the current browser window and replace its content, 
including the Impatica presentation.  

It is highly recommended that this feature be selected when 
producing content for e-mail delivery. Some e-mail clients 
can only open hyperlinks that are specifically set to open 
within a new page. 

 

6.4.2 Media and Animations 

 

6.4.2.1 JPEG Images 
JPEG Quality 

You can specify the quality to be applied to JPEG 
images.  For most images, 70% quality will result in 
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significant compression without a significant loss of 
quality. 

 

 

Always Recompress JPEG Images 

When this option is selected, the translator will 
automatically recompress all of the JPEG images in 
the presentation. If it is not selected, only those 
JPEG images that have been scaled or cropped 
within PowerPoint will be recompressed. 
Recompressing decreases the file size, but also 
degrades the quality of the image. 

 

6.4.2.2 Wait for Sound 
Impatica for PowerPoint’s Wait for Sound options 
facilitate the synchronization of narration with the 
presentation.   It is highly recommended for most 
presentations. 

At end of animation 

With this option selected, presentation advancement 
will be delayed until the current animation’s sound 
has been played to its entirety.  

At end of slide 

Selecting this option causes slide transitions to be 
postponed until the current slide’s transition sound 
has finished playing. 

6.4.2.3 Video 
Encode for: 

Selecting this option directs Impatica for 
PowerPoint to translate any embedded videos 
found within the source PowerPoint presentation.  A 
target speed must then be selected, and will be 
applied to all translated videos.  
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The following options are only enabled if the user 
has chosen to encode video. 

 

Target Connection Speed (1) 

The Target Connection Speed (kbps) refers to the 
expected or desired connection speed over which 
the Impaticized presentations are to be viewed.  
There are several pre-selected standard speeds - the 
“Still” option is included for very low bandwidth 
applications in which it may not be possible to 
achieve reasonable quality video. This option will 
translate the sound and first frame of the video. To 
set a custom target connection speed, simply type in 
the desired value.  

Frame Rate (2) 

The frame rates displayed in the Frame Rate box 
represent a range of values, from 1 to File.  If the 
File option is selected, the frame rate used for 
translation will be that of the original AVI video 
file(s).  The other rates presented are rough 

1

2

3
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guidelines only, and will be mapped to specific 
values during translation.  

For example, selecting Med will cause the 
translator to select frame rates that are near the 
middle of the range of possible values for each 
video referenced in the source PowerPoint 
presentation.  Note: only frame rates that are 
factors of the source are possible.   

Network Overhead % (3) 

Your network overhead may vary depending on the 
type of network or device connection.  Default 
values of network overhead for Internet delivery 
will be displayed in the Network Overhead (%) 
box and may be altered accordingly.  As a general 
rule, you may wish to start with the values as 
presented in the interface.  The following table 
suggests network overhead settings for various 
output devices.  

Output Target (kbps)/ 
Network/Device Type 

Network Overhead 
(%) 

Still Not Applicable 

56 20 - 25 

64 20 - 25 

128 15 - 20 

256 10 - 15 

LAN 5 - 10 

CD-ROM/CD-R 0 

Hard Disk 0 
 

6.4.2.4 Make All Animations Automatic 
Selecting this option will cause Impatica for 
PowerPoint to override the animation on mouse click 
setting of PowerPoint.  If this option is selected, all 
animations will occur automatically, without waiting for 
a mouse click. 
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6.4.2.5 Use Compact Sound 
The Use compact sound option allows users to control 
the degree of sound compression applied during 
translating.  When the option is selected, Impatica for 
PowerPoint will convert sound objects to Impatica’s 
compact sound format, which is designed for streaming 
sound over the Internet.   

When the option is left unselected, sound will be 
converted to a larger, but higher quality sound format.  
This would be appropriate when distributing content via 
CD-ROM or within a controlled network where a 
sizeable bandwidth is always available to the end users.   
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6.5 Translating Your Presentations 
Once you have selected all of the files that you wish to convert and have 
added them to the Source Files list, click Translate.   

  

When you click the Translate button, the Translation in Progress box will 
appear showing the progress as each presentation is translated.  In some 
cases, it may take a few moments for progress to begin showing. Below the 
progress bars, the source and destination file names and translation settings 
are displayed. 

Encoding of embedded videos, if it is enabled, will be performed following 
the translation of all of the slides in the source presentation.  During the 
video encoding, the progress and description of each video file are displayed. 
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You can use the Skip or Skip Remaining buttons to interrupt the translation 
process:  Skip will stop the translation of the current file, while Skip 
Remaining will halt translation of the current file and all remaining files.  In 
each case, any files that have already been translated are unaffected.  When 
all files have been translated or skipped, a new panel will appear, presenting 
several options: 

1. preview the translated presentations; 

2. delete one or more converted files; 

3. upload files to a Web server;  

4. view file information; and 

5. view the HTML required for sending your presentation by e-mail. 
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6.6 Preview 
To view the translated Impatica presentations simply click the Preview 
button.  Internet Explorer will be launched and the selected Impatica file 
will be played. 

6.7 Deleting Impatica Files 
Simply select the Impatica file you wish to delete and click the Delete File 
button. Any associated files, such as HTML files, will also be removed from 
your hard drive. 

6.8 Translation Summary 
Impatica for PowerPoint produces a translation summary to report the 
successes, warnings and problems encountered during translation. The 
translation summary will appear automatically after translation if any 
warnings or problems occurred during translation.  

To view the translation summary, in the File menu, choose “Show 
Translation Summary”. 

1

4

3 

2

5
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The translation summary will appear, displaying the results of the translation. 

 



Impatica for PowerPoint User’s Manual  

Version 2.5.1  Page 34 

 

6.9 Web Server Upload Tab 

6.9.1 Establishing a Connection to your Web Server 
Before you can upload your Impatica files or applet to your FTP 
server, you must first establish a connection to the server. This 
may require some assistance from your technical support person. 

Click on the Connect button on the Web Server Upload tab.  The 
following dialog box will appear: 

  

The connect dialog box will present you with the information for 
your default account or for a new account if no accounts have been 
previously specified.  From the Account menu, which can be 
accessed by clicking on the button at the right of the Account 
Name field, you can choose to create a new account, delete the 
current account, make the current account the default or choose a 
different account.  
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For each account, you must specify values for the following 
settings: 

• FTP Server Name; 

• FTP Port (optional); 

• FTP User Name; 

• FTP Password; 

• Web Documents Folder;  

• Web Site Location; 

• Connection type; 

• Upon Connecting, Ensure the applet is on the server; and 

• Remember password. 

If you are uncertain about any of these values, please contact your 
web master or service provider for details. 

The FTP Server Name is the domain name or numerical IP 
address of the FTP server to which you wish to upload the 
translated files, e.g., “ftp.yourserver.com” 
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The FTP Port is an optional parameter that may be required due to 
the unique set-up of your FTP server.  The default value is port 21. 
Normally, this field is left blank. 

The FTP User Name and FTP Password are used to authenticate 
your identity when connecting to the FTP server. 

The Web Documents Folder is the public folder on the FTP 
server that contains HTML and supporting files that are published 
to the web site.  This field must contain the name of the folder or 
be left blank when the web documents folder coincides with the 
FTP home folder.  The FTP home folder is the folder that is 
presented upon connecting to the FTP server. 

The Web Site Location is the address (URL) for the web server 
(HTTP server).  It is the address value you supply to a web 
browser to view the top page of your web site. 

The Connection type can be set to Active or Passive. Active is the 
default connection type that will be applicable to most FTP 
servers.  In certain cases, especially with firewalls, you may have 
to use a passive connection.  Generally, if an active connection 
fails, the protocol will automatically revert to passive. 

The Upon Connecting, Ensure Applet is on the Server setting 
specifies whether or not Impatica for PowerPoint should verify 
that the applet files exist on the FTP server.  When this option is 
selected, the files will be automatically uploaded if they are not 
already on the server. 

The Remember Password checkbox allows you to indicate either 
to save an encrypted version of your password with the other 
settings or to omit the password from saving. 

If you make any changes to your accounts, you will be prompted to 
save changes upon clicking Connect or Cancel.  

6.9.2 Navigating through Files on your Server 
To open a folder on the server, select it from the list and click 
Open. Alternatively, you may double-click on the folder. 

6.9.3 Creating a New Folder on your Server 
To create a new folder, first navigate to the appropriate location. 
Click the New Folder button. Enter the desired folder name and 
click OK. 
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6.9.4 Deleting a File or Folder from your Server 
To delete any file or folder from your server, simply select it and 
click Delete.  If you choose to delete a folder, all of its contents 
will be deleted before deleting the folder itself. 

6.9.5 Uploading Files 
To upload one or more Impatica files, you must first navigate to 
the appropriate location on your FTP server.  To upload the HTML 
required to launch your presentation, ensure that the Include 
HTML checkbox is selected. To upload the currently selected 
Impatica file, simply click Put File.  To upload the whole list of 
translated files, click Put All Files.   

     

The Put Other button can be used to upload any type of file, for 
example: 

• Previously translated files 

• Custom HTML  

• PowerPoint notes that were converted to HTML or text 
during translation   
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Simply click the Put Other button and choose a file from the 
Open dialog box that appears. 

6.9.6 Previewing Files from your Server 
To view an Impatica file from your server, select the desired 
HTML file from the list of remote files. Click the Open button or 
double click on the HTML file.  The HTML file will open in 
Internet Explorer. 

6.10 File Info Tab 
The File Info tab provides you with information regarding the source 
PowerPoint file, the translation settings and the resulting Impatica file. To 
view the information for a different file, select it from the translated file list 
while the File Info tab is visible. 

 

6.10.1 Source PowerPoint File 
The name, size, and modification date of the source PowerPoint 
file are provided for identification and comparison with the 
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resulting Impatica file. In addition, the total translation time is 
listed. 

 

6.10.2 Translation Settings Used 
The settings specified for the translation of the file are shown. This 
is particularly useful when translating the same file with multiple 
sets of translation settings.  It helps identify which mix of settings 
best suit your needs. 

6.10.3 Translated Impatica File 
The name, size and transfer time for the translated file are shown. 
The size is presented both in bytes and as a percentage of the 
source PowerPoint file. The transfer time provided is the time that 
it will take a viewer to obtain all of the data required for the 
presentation using a slow speed modem. Use this value to gauge 
the performance of your presentation over slow connections. If the 
desired playback time is less than this transfer time, your viewers 
will experience some delay during the presentation.  If this is the 
case, and some of your target audience has a slow speed 
connection, consider reworking the design of your presentation. 
See Section 10, Tips and Tricks. 
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6.11 E-mail HTML Tab 
When you use Impatica for PowerPoint to send your content by e-mail, the 
content is not embedded in the e-mail message, nor is it attached to it. Rather, 
the e-mail contains a few lines of HTML code that refer to your converted 
presentation.  Upon uploading your file, this HTML code will be 
automatically generated by Impatica for PowerPoint. 

To view the HTML required to e-mail your presentation, select the E-mail 
HTML tab and choose the desired file from the list of translated files.  

The e-mail HTML will only appear once the file has been uploaded (see 
Section 6.9, Web Server Upload Tab for upload instructions).  

To copy the HTML required for e-mail to the clipboard, click the Copy 
HTML button. You can now switch to the HTML editor portion of your e-
mail client, if it exists, and paste the HTML.  

Alternatively, you may wish to save the e-mail HTML as a text file. To do 
so, click the Save button, choose an appropriate location and name and click 
Save. 
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6.11.1 Attributes of the E-mail HTML 
To ensure that your Impaticized presentation will be received and 
enjoyed by the widest possible audience, the e-mail HTML 
generated by Impatica for PowerPoint includes several nuances 
to address the following issues: 

• Informing the recipients that the e-mail contains rich media 
content; 

• Dealing with e-mail clients that cannot display rich media 
content.   

6.11.1.1 Notification of Rich Media Content 
The recipients of your rich streaming e-mail may not be expecting 
a narrated, animated message. To inform your viewers, Impatica 
for PowerPoint includes the message “This e-mail contains a rich 
media presentation.” 

In addition, in your e-mail message editor, you may want to add 
text such as: “Please ensure that your sound is turned up and that 
you are online.” This would help ensure that your viewers have the 
most complete experience possible. 

6.11.1.2 Link to Display Rich Media Content 
Also, some recipients' e-mail clients may not be able to display 
rich streaming e-mail messages within their e-mail window.  To 
ensure that all of your recipients have access to the content, 
Impatica for PowerPoint adds a link to the content.  

If the recipient's e-mail program cannot process the Java applet, the 
added link will be displayed in the recipient's e-mail window. 
When they click on the link, the Impaticized presentation will be 
displayed in their browser as it should have been displayed in their 
e-mail window.  

6.11.2 Sending Impatica Content Through E-mail 
Many desktop e-mail programs are capable of sending HTML 
encoded e-mail messages, including Outlook Express 5, Outlook 
2000, and Netscape Messenger 4.7 for Windows, etc. 
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6.11.2.1 Outlook Express 5 
1. Open a New Message window. 

2. At the bottom of the window, click the Source tab. 
If the Source tab is not visible, from the View 
menu, select Source Edit. 

3. Paste the e-mail HTML into the message area, 
replacing the default HTML that may be present. 

 
4. Click on the Preview tab to test your content. 

5. Click on the Edit tab. 

6. Address and send your e-mail in the normal fashion. 

6.11.2.2 Outlook 2000 
1. Save the e-mail HTML. 

2. Open the HTML document in Internet Explorer. 

3. From the Edit menu, choose Select All. 
4. From the Edit menu, choose Copy. 

5. Launch Outlook. 

6. To ensure that Outlook is enabled to send HTML 
content, from the Tools menu, select Options and, 
in the Options Window, click on the Mail Format 
tab and select HTML as the message format. 

7. Open a New Message window. 
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8. Click anywhere in the message area and from the 
Edit menu, choose Paste. 

9. Address and send your e-mail in the normal 
manner. 

6.11.2.3 Netscape Messenger 4.7 
1. Open a New Message window. 

2. Click on the Options button. 

3. In the Format drop down box, select Plain Text 
and HTML. 

4. Copy and Paste your e-mail HTML into the 
message area. 

5. Unfortunately, Netscape Messenger modifies the 
HTML you insert, often rendering it inoperative. To 
verify and remedy this, in the Tools menu, select 
HTML Tools and Edit HTML Source. Edit out 
any extraneous information that has been added by 
Netscape Messenger. 

6. Alternatively, you can enter your HTML directly 
into the HTML Edit window.  Unfortunately, it is 
not possible to Copy and Paste your HTML directly 
into the HTML Edit window. 

7. Click OK to close the Edit HTML window. 

8. Address and Send your e-mail in the normal 
fashion. 

6.11.2.4 Other E-mail Alternatives 
In addition to desktop e-mail programs, there are 
numerous Application Service Providers that offer 
broadcast e-mail services and a growing number of 
software products that are fully HTML capable. For 
further information, contact Customer Support at 
Impatica. 
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7777    Supported and Unsupported Features of Supported and Unsupported Features of Supported and Unsupported Features of Supported and Unsupported Features of 
PowerPointPowerPointPowerPointPowerPoint    

7.1 Overview 
Impatica for PowerPoint supports a vast array of PowerPoint features 
and elements.  The supported elements have been carefully selected to 
maximize functionality and flexibility while minimizing file and player 
size.  As this document and your own experience will show, almost 
anything you can accomplish with PowerPoint can be implemented using 
the supported features. 

This section of the User’s Manual enumerates the PowerPoint features that 
are supported in Impatica for PowerPoint and those that are not. 

For some of the more popular features that we do not yet support directly, 
we provide sample workarounds that are easy to use.  These are 
documented in the section entitled Tips and Tricks. 

7.2 File Formats 

7.2.1 Supported 
Impatica for PowerPoint supports PowerPoint 97, PowerPoint 
2000, and PowerPoint 2002 (XP) file formats. 

7.2.2 Not Supported 
Impatica for PowerPoint does not support presentations saved as 
“PowerPoint 97-2000 & 95 Presentation” format. 

Impatica for PowerPoint does not support PowerPoint 98 or 
PowerPoint 2001 for Macintosh file formats. 

Impatica for PowerPoint does not currently support PowerPoint 
2002 (XP)-specific features. 
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7.3 Slides 

7.3.1 Page Setup 

7.3.1.1 Supported 
Impatica for PowerPoint will faithfully preserve any 
size and orientation of slides for your presentation. 
Impatica For PowerPoint ensures that this is the case in 
the HTML it automatically generates. It is not possible 
to change the slide size of the presentation during or 
after translation. 

7.3.1.2 Not Supported 
none 

7.3.2 Slide Masters 

7.3.2.1 Supported 
Impatica for PowerPoint will correctly translate slides 
that use or modify backgrounds, graphics, placeholder 
formats, footers, animation effects and other attributes of 
the slide master and, if present, the title master.   

Specifically, Impatica for PowerPoint supports slides 
that: 

• Use Master Slide defaults; 

• Modify Master Slide formats and attributes; 

• Override default formats and attributes; and  

• Omit Master Slide graphics. 

7.3.2.2 Not Supported 
none 

7.3.3 Backgrounds 

7.3.3.1 Supported 
Impatica for PowerPoint supports the following types 
of Backgrounds on individual and Master slides: 

• Solid fills 
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• Gradient fills 

• Pictures 

• Textured fills 

• Patterned fills 
Selective omission of “background graphics from 
master” (as specified in the Background dialog box) is 
also supported by Impatica for PowerPoint. 

7.3.3.2 Not Supported 
none 

7.3.4 Slide Design Templates 

7.3.4.1 Supported 
Impatica for PowerPoint supports all standard and 
custom slide design templates that utilize supported 
shapes, graphic objects and animation effects.   

All of the design templates distributed with PowerPoint 
97 and 2000 are translated acceptably by Impatica for 
PowerPoint. 
The following design templates distributed with 
PowerPoint 2002 (XP) are also translated acceptably by 
Impatica for PowerPoint: 
• Balloons 

• Beam 

• Blends 

• Cascade 

• Cliff 

• Compass 

• Competition 

• Crayons 

• Curtain Call 

• Echo 

• Fading Grid 

• Fireworks 

• Globe 
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• Kimono 

• Layers 

• Level 

• Maple 

• Mountain Top 

• Network 

• Orbit 

• Pixel 

• Profile 

• Quadrant 

• Radial 

• Refined 

• Ripple 

• Satellite Dish 

• Slit 

• Stream 

• Studio 

• Teamwork 

• Watermark 

7.3.4.2 Unsupported 
PowerPoint 2002 (XP) Design Templates 

Impatica for PowerPoint will translate the following 
PowerPoint 2002 (XP) design templates, but may have 
unexpected results due to their use of unsupported 
features:  
• Axis 

• Balance 

• Capsules 

• Clouds 

• Digital Dots 

• Eclipse 

• Edge 
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• Glass Layers 

• Ocean 

• Proposal 

• Textured 
 

7.3.5 Slide Layouts 

7.3.5.1 Supported 
Impatica for PowerPoint supports translation of all 
Slide Layouts, but will not translate unsupported 
elements that have been inserted into the slide. 

7.3.5.2 Not Supported 
none 

7.4 Text 

7.4.1 Text Types  

7.4.1.1 Supported 
Impatica for PowerPoint supports default text 
properties that are set within the Title and/or Slide 
Master, or by the default shape properties.  The 
following text types are supported: 

• Title (style set on Slide Master) 

• Body (style set on Slide Master) 

• Text in a shape (including text boxes) 

• Center Title (style set on Title Master) 

• Center Body (style set on Title Master) 

• Half body (text used in a two-column slide) 

• Quarter body (text used in a four-body slide) 

7.4.1.2 Not Supported 
none 
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7.4.2 Text Formatting 

7.4.2.1 Supported 
Impatica for PowerPoint will translate and faithfully 
render text with the following formatting attributes, 
whether these attributes are default attributes from 
Master slides or attributes that are set within individual 
slides: 

• Bold, italic, underline, shadow, and their 
combinations 

• Fonts 

• Sizes 

• Colors 

• Center, Left and Right Alignment 

• Left Margin 

• First line indent 

• Line spacing  

• Space before & after paragraphs 

• Bullets with various fonts, sizes & color 

• Tabs 

• Special Characters 

• Super/sub script 

• Vertical and horizontal alignment in a shape 

• Rotation of text 

• Rotation of text within a rotated shape 

• Shadowed text (if shadow applied to text via Font 
menu) 

• WordArt  (2D) 

7.4.2.2 Not Supported 
The following text attributes are not supported by 
Impatica for PowerPoint: 

• Embossed effects   

• Full Justification 
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• Auto-numbered text 

• Picture bullets 

• Animated bullets 

• 3D Shape and WordArt effects 

Although these features are not supported by Impatica 
for PowerPoint, most can still be used in your 
presentation if you convert the text to a “Picture” prior 
to translation.  Please see Section 10, Tips and Tricks. 

7.5 Graphics 

7.5.1 Formats 

7.5.1.1 Supported 
Impatica for PowerPoint supports the following 
graphics formats that can be inserted into your 
PowerPoint presentation: 

• JPEG 

• PNG 

• GIF  

• WMF (Windows Clip Art) 

• Windows Enhanced Metafile (EMF)   

• TIF 

• Tables 

• Organization Charts  

• Charts and Graphs   

7.5.1.2 Not Supported 
Impatica for PowerPoint does not support the 
following graphic formats: 

• PICT (Mac ClipArt format) 
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7.5.2 Image Manipulation 

7.5.2.1 Supported 
Microsoft PowerPoint provides features for 
manipulating images (in the Format Picture dialog box) 
after they have been imported into a PowerPoint 
presentation. 

Impatica for PowerPoint supports the following image 
manipulation features: 

• Scaling  

• Cropping  

7.5.2.2 Not Supported 
Impatica for PowerPoint does not support the 
following image manipulation features: 

• Color Adjustments (e.g. grayscale, black & white, 
etc.) 

• Brightness and Contrast control 

7.6 Shapes 

7.6.1 Shape Types 

7.6.1.1 Supported 
Impatica for PowerPoint supports translation and 
rendering of: 

• Lines 

• Autoshapes 

• Free-hand Polygons  

• Connectors 

• WordArt (2D) 

7.6.1.2 Not Supported 
none 
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7.6.2 Shape Formatting 

7.6.2.1 Supported 
Impatica for PowerPoint supports the following shape 
formatting features and attributes: 

• Solid color fills 

• Solid color outlines 

• Varying line thickness 

• Arrowheads (one size only for each arrow type) 

• Rotation  

• Horizontal & vertical flip 

• Scale 

• Grouped shapes 

• Gradient, pattern, texture and picture fills 

• Shadow effects   

• Alterations of most Autoshapes using the 
customization handle (yellow diamond) 

7.6.2.2 Not Supported 
Impatica for PowerPoint does not support the 
following shape formatting features and attributes: 

• Line Styles 

• 3D effects   

Although these features are not supported by Impatica 
for PowerPoint, they can still be used in your 
presentation if you convert the object to a “Picture” 
prior to translation.  Please see Section 10, Tips and 
Tricks. 

7.7 Animation 

7.7.1 Objects that can be Animated 

7.7.1.1 Supported 
Impatica for PowerPoint supports the translation and 
playback of Animation Effects that are applied to the 
following types of objects: 
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• Text as a single block 

• Text separated by paragraph levels 

• Any supported shape 

• Any supported graphic format 

• Groups of shapes 

• AVI Movies inserted from file 

7.7.1.2 Not Supported 
Impatica for PowerPoint does not support  

• Text separated by words or characters 

• Chart effects 

• Animation of Media Objects 

7.7.2 Animation Effects 

7.7.2.1 Supported 
Impatica for PowerPoint supports the following 
Custom Animation Effects that can be applied to any of 
the object types listed above: 

• Appear 

• Blinds  

• Box 

• Checkerboard 

• Crawl  

• Dissolve 

• Fly  

• Peek 

• Random Bars 

• Split 

• Stretch 

• Strips 

• Spiral 

• Swivel 

• Wipe 
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• Zoom  

• Hide after animation setting 

• Sounds with effects 

• Stop sound with effects 

7.7.2.2 Not Supported 
Impatica for PowerPoint does not support the 
following Animation Effects: 

• Other after animation effects 

• Chart effects 

7.7.3 Timing 

7.7.3.1 Supported 
Impatica for PowerPoint supports the translation and 
playback of Animation Effects that are triggered both 
automatically and on mouse click.   

Also supported are animation timings that are 
established using the Rehearse Timings or Record 
Narration features. 

7.7.3.2 Not Supported 
• Multimedia (Play) Settings for Media Objects: 

• While playing (Impatica for PowerPoint 
optionally provides the playback console for 
these operations): 

• Pause slide show 

• Continue slide show 

• Stop playing: 

• After current slide 

• After … slides 

7.8 Media  

7.8.1 Supported 
Impatica for PowerPoint supports translation and playback of:  
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• Recorded narration that is embedded within the PowerPoint 
presentation (i.e., not linked).  

• Sound effects on Slide Transitions 

• Imported “Other Sounds” on Slide Transitions 

• Sounds with animation effects 

• Linked sounds (stored in external files) - Please refer to 
Narration in Section 10, Tips and Tricks. 

• AVI Movies inserted from file - Please refer to Video in 
Section 10, Tips and Tricks. 

7.8.2 Not Supported 
Impatica for PowerPoint does not currently support: 

• Play sound as an Action Setting 

• Sound and Movies inserted as Objects 

7.9 Action Settings and Hyperlinks 

7.9.1 Supported 
Impatica for PowerPoint supports the following Action Settings 
on shapes, graphics, textboxes and placeholders. 

Action on Mouse Click: 

• Hyperlink to Next slide 

• Hyperlink to Previous slide 

• Hyperlink to First slide 

• Hyperlink to Last slide 

• Hyperlink to specific slide within the current presentation 

• Hyperlink to other PowerPoint Presentation 

• Hyperlink to URL 

• Hyperlink to an E-mail messages 

• Hyperlink to an Impatica (.imp) file through “Other File” 

• Hyperlink to Other File 

• Mouse pointer changing to hand when over a hyperlink 

Note that the action applies to the entire rectangular area enclosing 
the object, regardless of its shape. Also, action settings applied 
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directly to text will apply to the entire shape or textbox if there is 
not already an action associated with the whole object. 

7.9.2 Not Supported 
Impatica for PowerPoint does not support the following Action 
Settings: 

• Highlight button when clicked 

• Actions on Mouse Over 

• Hyperlink to Last Slide Viewed 

• Hyperlink to End Show 

• Hyperlink to Custom Show 

• Run Program 

• Run Macro 

• Object Action 

• Play Sound  

• Action settings on text 
 

7.10 Transitions 

7.10.1 Transition Effects 

7.10.1.1 Supported 
Impatica for PowerPoint supports the translation and 
playback of the following transition effects at user 
defined speeds: 

• None (no transition) 

• Blinds Horizontal and Vertical 

• Box In and Out 

• Checker 

• Cover Up, Down, Left and Right 

• Dissolve 

• Random Bars Horizontal and Vertical 

• Split Horizontal In, Horizontal Out, Vertical In and 
Vertical Out 
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• Wipe Left, Right, Up and Down 

• Zoom 

7.10.1.2 Not Supported 
The transition effects that Impatica for PowerPoint 
does not support are all mapped to similar effects, as 
the list below indicates. 

• Cut (mapped to Dissolve) 

• Cut through Black (mapped to Dissolve) 

• Cover Left-Up, Left-Down, Right-Up, Right Down 
(mapped to supported Cover effects) 

• Fade (mapped to Dissolve) 

• Random (mapped to Dissolve) 

• Strips (mapped to supported Cover effects) 

• Uncover (mapped to supported Cover effects) 

7.10.2 Slide Advance 

7.10.2.1 Supported 
Impatica for PowerPoint supports the following Slide 
Advance settings: 

• Automatically after … seconds  

• Advance on mouse click (or Keyboard spacebar) 

• Both Automatically and On Mouse Click 
In general, Impatica for PowerPoint will faithfully 
mimic playback as a PowerPoint Slide Show.  Note that 
the Impatica presentation must have focus in order for 
the keyboard event to take effect.   

7.10.2.2 Not Supported 
none 

7.10.3 Sounds 

7.10.3.1 Supported 
Impatica for PowerPoint supports the translation and 
playback of: 
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• No Sound 

• Stop Previous Sound 

• Incidental Sounds (e.g. Applause, Breaking Glass, 
etc.) 

• Other Sound 

For a more complete description of Impatica for 
PowerPoint’s support for sound, please refer to the 
Media topic within the Supported and Unsupported 
Features section and to Narration in Section 10, Tips 
and Tricks. 

7.10.3.2 Not Supported 
none 

7.11 Miscellaneous Features 

7.11.1.1 Supported 
Impatica for PowerPoint supports Color Schemes that 
may be specified at the master and/or individual slide 
level. 

7.11.1.2 Not Supported 
Impatica for PowerPoint does not support the 
following miscellaneous features: 

• Meeting minders 

• Action items 

• Custom shows 

• Agenda slide 

• Visual Basic support 

• Image map authoring tools and hot spots 

• Hidden slides 

• Notes 
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8.1 Overview 
PowerPoint presentations that are converted using Impatica for PowerPoint 
will play consistently and reliably over the Internet, provided that the 
presentation is designed or adapted to conform to the constraints of network 
delivery.  This topic describes how to adapt PowerPoint presentations for 
efficient and reliable delivery. 

8.2 Animation 
The Impatica for PowerPoint player performs all animation effects and 
most animation features that are supported by PowerPoint.  (Please refer to 
Animation in Section 7, Supported and Unsupported Features of 
PowerPoint) 

8.3 Navigation 
The Impatica for PowerPoint player supports basic Action Settings for 
navigation between slides.  Impatica for PowerPoint presently supports 
navigation within a presentation, between presentations and between 
presentations and other web pages.  Note the mouse pointer turns into a hand 
when passed over a hyperlink during playback of an Impatica file. (Please 
refer to Section 7, Supported and Unsupported Features of PowerPoint). 

8.3.1 Navigating Between Slides 
When an Impatica for PowerPoint presentation is played, the 
Impatica for PowerPoint player is normally streamed as part of 
the presentation unless the player is still in cache from playing a 
previous presentation.  When playing multiple presentations, either 
in conjunction with one another or independently, you can avoid 
subsequent downloads of the player applet depending on how you 
set up your server's file system.  Please refer to Section 10, Tips 
and Tricks. 

The Impatica for PowerPoint player loads elements in a linear 
fashion.  If a presentation jumps ahead to a later slide, all of the 
text, sound and graphic elements appearing on the skipped slides 
must be read before the target slide can be displayed.  Therefore, 
navigation between slides of a single presentation must be 
designed very carefully to avoid delays between the source and 
destination of a branch.   
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Although Impatica for PowerPoint does support the Action 
Setting “Hyperlink to Last Slide” and “Slide…”, use of these 
features is discouraged since the entire remainder of the 
presentation must stream in order for the last slide to be displayed.   

The better alternative is to separate the presentation into multiple 
presentations and use the “Hyperlink to Other PowerPoint 
Presentation” feature to allow the user to navigate through blocks 
of slides. To find out more, refer to Section 10, Tips and Tricks. 

For enhanced navigation capabilities, Impatica for PowerPoint 
optionally provides playback controls which allow the viewer to 
navigate to the previous slide, next slide, beginning of the 
presentation, as well as to pause/play the presentation.  See Section 
6.4.1, Slide Show, for details on how to enable playback controls. 

8.3.2 Navigating Between Presentations 
Impatica for PowerPoint supports hyperlinks to other PowerPoint 
presentations and to Impatica files. The ability to hyperlink to 
Impatica files allows for the integration of content created with 
Impatica for Director and Impatica for PowerPoint.  

In each case, the target presentation must be translated 
independently of the presentation containing the hyperlink.  When 
using the hyperlink to other PowerPoint presentation method, the 
target presentation must be translated with the default save name. 

It is also necessary that relative paths be preserved. If 
presentation1.ppt contains a hyperlink to presentation2.ppt, the 
location of presentation2.imp relative to presentation1.imp must be 
the same as the location of presentation2.ppt relative to 
presentation1.ppt.  The same is true of Impatica files to which a 
PowerPoint presentation hyperlinks. 

Due to Java security features, applets have access only to the 
contents of the folder in which they are stored and its sub-folders. 
This is to prevent applets from navigating upwards through the 
contents of a server. The Impatica applet is no exception; therefore, 
it can only play Impatica files stored in the folder that contains it 
and that folder’s subfolders.  
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Consider the example above. If the Impatica applet launched is in 
folder0, then Impatica files in folder0, folder1 and folder2 may be 
played. However, if the applet is launched from folder1, only 
content in folder1 and folder2 can be played.  

When an Impatica file is viewed locally, either by clicking 
Preview button in Impatica for PowerPoint or by launching the 
generated HTML, the Impatica applet that is launched is in the 
folder containing the desired Impatica file. Therefore, for local 
viewing, the first presentation launched must be at the top-most 
level of the files that hyperlink to each other. 

Once the files are uploaded to the server, they all reference the 
same applet that must always be at the same level or above the 
Impatica files. Therefore, if the folder structure illustrated above 
is replicated on the server, all files contained in the folders may 
hyperlink to each other, regardless of their enclosing folders. 

* Remember: When uploading to the server, duplicate the folder 
structure containing the original PowerPoint and 
Impatica files. 

8.3.3 Navigating Between Presentations and URLs 
Files translated with Impatica for PowerPoint can contain 
hyperlinks to URLs, including e-mail.  When clicked, hyperlinks to 
web pages will either be opened within the current browser 
window, or in a new browser window (if you have selected the 
Make Hyperlinks Open New Window option – see Section 6.4.1, 
Slide Show). Hyperlinks to e-mail will launch the default e-mail 
client with the supplied information filled into a new message. 
Similarly, hyperlinks to news servers will use the default news 
client to display the specified newsgroup. 

In PowerPoint 2000, the hyperlink is specified by right clicking on 
the object and choosing Action Settings or Hyperlink. The 
Hyperlink option offers a convenient interface for choosing web 
pages and specifying e-mail addresses and subjects. 

In PowerPoint 97, right click on the object and choose Action 
Settings. Click the Hyperlink To radio button and choose URL 
from the drop down list. To specify an e-mail address, in the URL 
field enter mailto: followed immediately by the e-mail address. 

To have hyperlinks open a URL in a new browser window, ensure 
that the “Make hyperlinks open new window” translation setting is 
selected when translating.  It is recommended that this setting be 
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selected when translating presentations targeted for e-mail 
delivery, since some e-mail clients will open only those URL’s that 
are designated to open in a new window. 

8.3.4 Navigating Between Presentations and Other Files 
Impatica for PowerPoint will preserve hyperlinks to other files 
specified with either an absolute or a relative path. The link to files 
other than Impatica files will be handled by the web browser or e-
mail client in which the presentation is playing. Therefore, special 
care should be taken when using file types that cannot be handled 
by all browsers. 

 

8.4 Narration 
Impatica for PowerPoint will correctly read and format PowerPoint audio 
and convert and compress it to Impatica's streaming format (if the Use 
compact sound option is selected).  Note that PowerPoint for Windows only 
supports PCM .wav format audio. 

8.4.1 Sound Quality 
Good quality audio delivery over the Internet depends to a large 
extent on the quality of the original sound clip.  Please refer to 
Narration in Section 10, Tips and Tricks. 

Depending on the equipment and recording environment, it may be 
possible to achieve acceptable results by recording narration using 
PowerPoint on your desktop computer.  However, if the nature of 
your presentation or the characteristics of your intended audience 
warrants professional quality audio, you might consider using 
professional voice talent and a commercial recording studio. 

In any case, it is recommended that the following audio settings be 
used when recording audio: 

• 8000 Hz 

• 16 bit 

• Monaural. 

8.4.2 Controlling Sound 
The current version of Impatica for PowerPoint supports sound 
effects and imported “Other Sound” on slide transitions.  Animated 
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sound, sound effects, and other sounds are also supported when 
added to animations. 

8.5 Keyboard and Mouse Input 
Keyboard and mouse behavior in an Impaticized presentation may be 
slightly different from original PowerPoint presentations. 

8.5.1 Keyboard Input in an Applet 
Keyboard input (spacebar only) during playback is recognized by 
the Impatica for PowerPoint player.  In order to receive this 
input, the applet presentation area must have focus in order for the 
keyboard input to take effect. In other words, the user must click in 
the presentation before any keystrokes can be recognized.  

8.5.2 Mouse Input in an Applet 
The player applet is able to respond to clicks of the left mouse 
button only. It does not have the ability to respond to right-click or 
mouse-over events. 

8.6 Path and File Names 
By their very nature, Java applets are designed to run on any Java-enabled 
platform, including Windows, Macintosh, Unix, Linux, OS/2, set-top boxes 
and many of the emerging handheld devices.  The Impatica for PowerPoint 
player applet can be launched and the associated Impatica content can be 
streamed from any HTTP server.  No special streaming server software is 
required.   

It is therefore important to specify pathnames and file names that are 
meaningful on your server platform(s).  The following conventions should be 
followed for any reference to server pathnames: 

• Do not use pathnames that begin with HTTP or FTP.  Impatica for 
PowerPoint does not support such pathnames. 

• Some servers, e.g., Unix, are case sensitive. 

• Avoid using spaces and underscores in file and folder names.  Some web 
browsers and e-mail programs have trouble handling them correctly.  Use 
dashes instead. When generating filenames for Impatica files, Impatica for 
PowerPoint automatically substitutes hyphens in place of spaces and 
underscores. 
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9.1 Overview 
When you use Impatica for PowerPoint to convert a PowerPoint 
presentation for web delivery, the content in the PowerPoint (.ppt) file is 
translated and reformatted into a corresponding Impatica (.imp) file.  To 
play this content over the Internet, a small Java applet player is invoked.  The 
Java applet consists of a series of .class files.  Class files are simply Java byte 
code programs that are executed (actually interpreted) by the Java Virtual 
Machine that is included in all Java enabled browsers or platforms.  The 
player applet initiates the reading (streaming) of the .imp content and plays 
the presentation on the user's computer.   

To play the Impaticized presentation over the Internet, an applet tag must be 
included in an HTML web page or within an e-mail message.  (Alternately, 
the Impatica for PowerPoint player applet can be launched from within 
another applet.) 

9.2 Setting up the HTML to Play Your Presentation Content 
Once you have converted your PowerPoint presentation to Impatica's 
streaming format, you are ready to play the content. There are three 
components involved in the playback of the Impatica for PowerPoint files: 

1. The content, namely the .imp file that is created in the translation process 
(if there are embedded videos that were encoded, there will also be one or 
more .imv files); 

2. Impatica's player, comprising a number of Java “.class” files that read, 
interpret and display your content at run time.  As well, all of the .class 
files are contained in a single compressed jar (Java ARchive) file that 
provides faster performance when accessed by browsers such as Netscape 
Navigator and Internet Explorer, Version 3 and later; 

3. A few lines of HTML within a page of your web site or an e-mail 
message that tells the browser or e-mail client where to find the Java 
player and presentation files. 

The process of engaging your viewers begins when they access a page on 
your web site or open an e-mail message that contains an HTML reference to 
Impatica content. Based on the location specified in the HTML, the browser 
or e-mail client downloads and launches the Java player in a process that is 
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virtually invisible to your viewers. The player then opens the content file and 
begins to read, interpret and display your presentation. 

If the translation setting Generate HTML is selected, Impatica for 
PowerPoint creates a sample HTML document containing the code required 
to play your content from your hard drive. For most applications, the HTML 
generated can be used without modification. The player applet will be added 
to the folder upon previewing the presentation from within Impatica for 
PowerPoint.  Note that this HTML document is intended to play your local 
content (on your hard drive) only, and cannot be used to view content on 
your web site. 

For content that is being uploaded to your web site, ensure that the Include 
HTML checkbox is selected upon uploading. This will automatically 
generate an HTML page capable of launching your online presentation. To 
include your Impaticized content within a custom web page, please refer to 
Section 9.4, Adding Impatica Content to Your Web Site. 

In order to playback the online content, there must be a copy of the player 
applet on your server. When connecting, select the checkbox Upon 
Connection, Ensure Applet is On Server. This will guarantee that a copy of 
the Impatica Player, including both the .class and .jar files, exists in the 
necessary folder within the web documents folder. The converted content 
must be uploaded to the same location as the player files  or to a sub-folder 
within that location.   

For content that is to be distributed by e-mail you must first upload the 
content and ensure that the player is on your server. Next, simply copy the 
HTML provided in the E-Mail HTML tab of Impatica for PowerPoint into 
the body of the e-mail message. (Please refer to 
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E-mail HTML Tab in Section 6, Using Impatica for PowerPoint for 
additional details.). 

9.3 Testing 
As with all Internet delivered content, you should test the content extensively 
with as many browsers and/or e-mail programs as possible before you add 
your newly converted presentations to your live web site or broadcast them 
through e-mail. 

You can do the testing in stages: 

1. From your hard drive; 

2. From your web server. 

9.3.1 Testing From Your Local Hard Drive 
As soon as the translation process is complete, you can select  a 
file from the list of Impatica files and click the Preview button.    
This will launch Internet Explorer and play the converted 
presentation.  

An alternative method of testing your Impaticized presentation 
from your hard disk is to run it using the HTML document created 
during translation.  If the Generate HTML checkbox was selected 
as a translation setting, an HTML document was created and stored 
in the same folder as the translated presentation. Double click the 
HTML document. Doing so will launch your default browser and 
open the HTML page, thereby invoking the Impatica Player.  It, in 
turn, will play your converted content.  

Ideally, even this initial test should be repeated with as many 
different browsers as possible.  To play the Impaticized 
presentation in other browsers, simply launch the browser you 
wish to test and select Open in the browser’s File menu to open 
the local HTML document. 

9.3.2 Testing From Your Web Server 
Once you are satisfied with your converted presentation, you are 
ready to test playback from a Web server.  Impatica for 
PowerPoint makes it easy to upload your Impaticized 
presentations, Impatica’s player and associated HTML documents 
to your web server. (See Section 6, Using Impatica for 
PowerPoint). 
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Following the instructions provided in Section 6.1, Running 
Impatica for PowerPoint, connect to your web server and upload 
your Impaticized presentations.  If the Include HTML checkbox is 
selected upon upload, the associated HTML files will be uploaded 
automatically to the same location.  To play your presentation, 
simply double-click on the corresponding HTML file (or 
alternately, select the HTML file and click Open).  The 
Impaticized presentation will play in Internet Explorer.  Within 
your browser, select the web page location and copy it. Test this 
location from within other browsers. 

 

9.4 Adding Impatica Content to Your Web Site 
After you have thoroughly and successfully tested your Impaticized 
presentation files (and the corresponding HTML) from your local hard drive 
and Web server, you may wish to incorporate your presentation within an 
existing Web page. 

Your webmaster will normally perform this step. 

Simply copy the <applet> portion of the HTML and insert it into the proper 
location within the desired Web page. 



Impatica for PowerPoint User’s Manual  

Version 2.5.1  Page 68 

10101010    Tips and TricksTips and TricksTips and TricksTips and Tricks    
This section contains a collection of topics that are intended to make it easier for 
you to create effective online presentations.  The topics presented are merely 
suggestions that might be helpful in preparing a more effective presentation and 
should not be misconstrued as precise rules that must be followed in order to use 
Impatica for PowerPoint. 

10.1 Designing for Performance 
Impatica for PowerPoint translates PowerPoint files into a highly 
efficient file format for streaming delivery over the Internet or through e-
mail.  However, to take maximum advantage of this capability, it is 
important to design your PowerPoint presentation with performance in 
mind.   

There are three important aspects to effective streaming performance: 

1. Determine the bandwidth or Internet connection speed required to play 
your content.  Use the transfer time provided in the File Info tab in 
Impatica for PowerPoint to gauge how well your file will playback. 
This measurement is the time that it will take for all of the data 
included in the presentation to reach the user’s computer. If this time 
exceeds the desired playback time, expect delays on a slow-speed 
modem. For example, if the transfer time is three minutes and the 
presentation is designed to playback in two and a half minutes, a 
viewer using a 28.8 kbps modem will experience a total of thirty 
seconds in delays during the playback of the content.  

2. Minimize the use of large multimedia objects, such as pictures and 
audio clips, within your presentation, especially at the beginning.  
Even though the translated file will stream over the Internet as the 
content is being played, each individual component (picture, audio 
clip, etc.) must be received in its entirety before it can be played or 
displayed.  As a result, large objects may cause un-natural delays 
during playback, especially if the overall presentation is at or close to 
the limit of the viewer’s Internet connection speed.   

This is especially true at the very beginning of the presentation.  If 
your presentation uses a design template that includes large pictures as 
backgrounds for each of the Title Master and the Slide Master, these 
background images as well as the objects on the actual slides must be 
streamed before the slides can be displayed. 
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To ensure good performance, keep individual audio clips small, ideally 
less than 30 seconds and avoid using large pictures, especially at or 
near the beginning of the presentation. 

3. Avoid using hyperlinks that jump ahead to the last slide, particularly 
early in the presentation.  Because the translated file is streamed 
sequentially, all of the intervening slides must be read before the target 
slide can be displayed.  If the hyperlink skips over several slides, there 
could be a noticeable delay before the target slide can be displayed.  
(See also Internal and External Branching in this section.)  

4. Make creative use of interactivity. Interactivity can be used to stall the 
playback of the presentation while keeping the viewer engaged. The 
pause in the presentation will allow the stream of information received 
to get ahead of the demand for data.  

For example, a presentation may begin with a slide that requires the 
user to click before advancing. The slide may remind users to turn up 
their speakers or it may pose a question. While the user is reading and 
responding to the slide, information such as sounds, graphics and text 
required for future slides is being collected. When the user progresses 
to future slides, the necessary data has likely already arrived; therefore, 
the probability that the user will have to wait is significantly reduced. 

10.2 Reusing Objects 
Impatica for PowerPoint checks for duplicate objects when creating the 
streaming media file.  If exact duplicate objects are detected, the second 
object is simply replaced by a reference to the first object.  However if 
objects are merely similar, but not exact duplicates, the substitution cannot 
be made and both objects will be placed in the streaming media file. 

10.3 Pictures and Other Large Images 
Photographs and other true color graphics are especially large and can 
noticeably degrade online performance of your presentation.  This is 
especially true if the pictures are at the beginning of the presentation.  
PowerPoint users who are unfamiliar with online delivery often make the 
mistake of using similar, but slightly different, JPEGs as backgrounds for 
both the Title Master and Slide Master.  For standard sized slides, each 
JPEG would be approximately 300KB, even after compression.  When 
viewed over a 28.8 modem connection, each JPEG would take almost two 
minutes to download.  Because backgrounds placed on the slide masters 
usually appear at the beginning of the streaming file, this would cause a 
substantial delay in starting your presentation.   
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By using the same JPEG for both the Title Master and Slide Master, that 
portion of the Impatica file would be reduced by 50%.  Even better, 
consider using a solid color background, or a background comprised of 
Autoshapes, for either or both of the Master slides.   

10.4 Narration 
Narration is a critical component of Internet or e-mail delivered 
PowerPoint presentations.  Here are some suggestions to make your 
narration more engaging and effective. 

• Be brief and to the point.  Online viewers have a very short attention 
span and they are only a single click away from leaving.  The narration 
for each slide should be no longer than one minute and preferably less 
than 30 seconds. 

• Use a script.  Even though you may be highly effective as a stand-up 
or impromptu presenter, your online presentation does not benefit from 
your presence and charisma.  More importantly, you do not have the 
benefit of watching and gauging your audience’s reaction and perhaps 
modifying your delivery accordingly.   

• Edit and re-edit the script to produce the shortest possible way of 
delivering a clear, concise and focused message. 

• Consider using a professional narrator and sound recording studio.  
This really depends on the objective of your presentation and on the 
intended audience.  If, for example, you are using professionally 
prepared graphics, your presentation probably warrants professional 
narration.  Try it yourself, review the results, and judge for yourself. 

• Identify the author of the presentation. Often viewers like to know who 
is speaking to them. Consider including a picture of the author, even if 
it is not the narrator, of the presentation. 

There are three methods of incorporating sound into a PowerPoint 
presentation that are supported by Impatica for PowerPoint. For a rich 
media lesson on inserting sound, please visit the FAQ section of our web 
site. Here are the steps to follow in PowerPoint for each of the three 
methods: 

1. Add external “pre-recorded” audio file to your presentation. 

• Add sound to slide transitions:  From the Slide Show menu, 
choose Slide Transitions.  In the Slide Transitions dialog box, 
click on the drop down box in the Sounds panel.  Select Other 
Sound.  The Add Sound dialog box will appear through which 
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you can select the external sound file to be added to the slide 
transition for that slide. This is the method most highly 
recommended by Impatica. 

• Add sound to slide:  From the Insert menu, choose Movies and 
Sounds, and click on Sound from File.  Select the audio file you 
wish to insert from the Insert Sound dialog box that appears.  If 
you wish to ensure that the sound file is linked externally (as 
opposed to embedded into the PowerPoint file), then from the 
Tools menu, select Options…, and click on the General tab of the 
Options window.  Set the Link sounds with file size greater than 
box to a value lower than the smallest audio file size you wish to 
link. 

2. Record narration for the entire presentation.  From the Slide Show 
menu, choose Record Narration.  Click on Change Quality to check 
the audio setting.  Specify 8.0 kHz, 16 bit, monaural.  When advancing 
slides, try using the “Page Down” key to avoid the sound of the mouse 
click. 

3. Record audio for a specific slide.  From the Insert menu, choose 
Movies and Sounds then, in the sub menu, Record Sound.  
Unfortunately, using this technique, PowerPoint will not let you 
specify audio settings and will record the audio using 8 bit samples 
and the audio will be of lower quality.  As a result, this technique, 
while supported by Impatica for PowerPoint, is not recommended. 

10.5 Video 
Video can be an effective and powerful way to enhance your PowerPoint 
presentations.  However, smooth delivery of video content over the 
Internet generally requires a bandwidth higher than that provided by dial-
up connections.   Therefore, it is important to understand the capabilities 
of your target audience, and tailor your presentations accordingly.  For 
example, consider offering multiple versions of your presentation(s), 
targeted to a variety of connection speeds. 

Impatica for PowerPoint supports embedded videos, if they are added in 
the following manner (inserting movies as Object is currently not 
supported): 

• From the PowerPoint Insert menu, choose Movies and Sounds 
then, in the sub menu, Movie from File. 

The only video format currently supported by Impatica for PowerPoint 
is AVI.  The use of various video codecs (coder/decoders) for 
compression is supported provided the appropriate decoder is available. 
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10.6 Synchronization and Timing 
Impatica for PowerPoint will honor the slide timings specified in 
PowerPoint.  However, when designing for the Web it is important to 
remember that different connection speeds yield different playback results. 

To ensure the proper synchronization of narration with slides or 
animations, use the Wait for Sound translation settings in Impatica for 
PowerPoint.  Content translated using these settings will ensure that the 
current slide’s or animation’s sound has entirely played before advancing 
to the next slide or animation, regardless of the connection speed. 

10.7 Internal and External Branching 
Impatica for PowerPoint supports PowerPoint's Action Settings for 
branching to the next, previous, first, last or particular slide in the same 
presentation. It also supports jumping to another PowerPoint presentation 
or to a specific Impatica file identified through the Hyperlink to Other 
File option. 

Although supported, branching to the last slide of a presentation is not 
recommended for slow speed delivery because the entire streaming file 
will have to be read before the last slide can be displayed.  Similarly, the 
use of hyperlinks to a slide that is ahead in the presentation requires 
special attention. Such actions may cause the end user to experience 
delays, since the content for all of the slides between the slide containing 
the hyperlink and the target slide would have to be streamed before the 
action could take place. The use of hyperlinks to other presentations is the 
preferred approach. 

10.8 Creating Hyperlinks 
Impatica for PowerPoint supports many types of hyperlinks. These 
hyperlinks may be applied to shapes, graphics, textboxes and placeholders. 
However, they cannot be associated with text directly. If the entire object 
does not already have an action associated with it, the first action 
encountered in the text will be applied to the entire object.  

When selecting a shape or textbox with which the hyperlink is to be 
associated, ensure that the object is selected and not its text. To select the 
object, click on its outer edge. A gray border made up of small dots should 
appear around the object, as shown. If the border is made up of diagonal 
lines instead and a cursor appears in the text or some of the text is 
highlighted, the shape is in text editing mode and the hyperlink will not be 
Impaticized.  
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Supported 
Object is selected 

Unsupported 
Text is selected 

 

 

 

 

 

 

If the hyperlink does get applied to the text rather than the object itself, the 
first hyperlink encountered in the text will be applied to the entire object if 
the object does not already have a hyperlink associated with it. 

With the object selected, right click. From the menu that appears, choose 
either Action Settings or Hyperlink….  

Action Settings allows the specification of the following supported 
targets: next, previous, first and last slides, a particular slide within the 
current presentation, a URL, another PowerPoint presentation and Other 
File. Only the actions for Mouse Click are supported by Impatica for 
PowerPoint.  

Hyperlink provides a means of specifying these types of supported 
hyperlinks:  an existing file or web page, a place in the current document, 
and an e-mail address. 
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10.9 Hyperlinks to Other Presentations 
Impatica for PowerPoint supports hyperlinks to other presentations. 
There are two options for specifying another presentation: by choosing a 
PowerPoint file or by specifying an Impatica file. 

10.9.1 Specifying a PowerPoint Presentation 
Within PowerPoint, there are three ways of specifying a link to 
another PowerPoint presentation: 

1. Right-click on the object, choose Action Settings, and click 
the Hyperlink to radio button, then pick Other PowerPoint 
Presentation and identify the desired presentation. 

2. Right-click on the object, choose Action Settings, and click 
the Hyperlink to radio button, then pick Other File and select 
the PowerPoint file. 

3. Right-click on the object, choose Hyperlink, click the File or 
Web Page button and select the PowerPoint file. (PowerPoint 
2000 and XP) 

When using the latter method, it is mandatory that the target 
presentation be translated in Impatica for PowerPoint using the 
default save name. Otherwise, the hyperlink in the Impaticized 
presentation will fail. 

10.9.2 Specifying an Impatica File 
To specify a hyperlink to an Impatica file from within 
PowerPoint, use one of the following methods: 

1. Right-click on the object, choose Action Settings, click the 
Hyperlink to radio button, then select Other File and choose 
the desired Impatica file. 

2. Right-click on the object, choose Hyperlink, click the File or 
Web Page button and choose the desired Impatica file. 
(PowerPoint 2000 and XP) 

The hyperlink to the Impatica file will not have meaning when 
viewing the presentation in PowerPoint. However, this method 
allows you to specify an existing Impatica file without naming 
restrictions.  It also allows hyperlinking between content created 
using Impatica for PowerPoint and Impatica for Director. 
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10.9.3 Hyperlink Considerations 
Regardless of the method used to specify a hyperlink to another 
presentation, there are a few issues to consider to ensure proper 
translation and playback. 

Firstly, the target presentation must be translated on its own. If the 
presentation has been identified as a PowerPoint presentation, it 
must be translated using the default save name. 

Secondly, the relative locations of the Impatica files must match 
the relative locations of the PowerPoint presentation that contains 
the hyperlink and the target presentation.  Java’s extensive security 
allows applets to access files only within the same folder or its sub-
folders. Therefore, Impatica files must be in the same folder as the 
Impatica player applet or sub-folders thereof.  When previewing 
locally, the copy of the Impatica player applet (ImPlayer.jar) that 
is launched is in the same folder as the first Impatica file played. 
Therefore, when viewing locally, the first presentation launched 
must be in the top-most folder. Any files hyperlinked to must also 
be within that folder or its sub-folders. Choosing to use a hierarchy 
of folders to store the presentations that hyperlink to each other 
requires the reconstruction of the hierarchy on the remote server 
and uploading of files into to the appropriate folders. 

While these methods allow for extensive flexibility in the 
arrangement and naming of files, Impatica recommends a simple 
approach. Keep all PowerPoint source files that link to each other 
in the same folder. Translate with the default save name and with 
the source folder as the save location. When uploading, put all of 
the files into the same folder. This approach will simplify the 
process and minimize the risk of broken hyperlinks. 

If, during the playback of an Impatica file, a hyperlink to a file is 
clicked and the Impatica applet is unable to find the specified file, 
a dialog box will appear notifying the user that the file could not be 
found. 

10.10 Setting up the Web Server 
Impatica's content is delivered from a standard HTTP web server using a 
Java player applet.  As a result, any standard web server set-up will work 
just fine.  However, for performance reasons, it is good practice to use a 
single instance of the applet (.class files and/or .jar files).   

When a Java applet is invoked, the browser first checks to see if the player 
is already in cache and, if so, uses the cached copy of the player instead of 
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downloading the player from the web server.  As a result, the content 
plays almost instantaneously.  However, the only way for the browser to 
ascertain that the required player is in cache is to compare the path names 
of the requested and cached players.  Therefore, all references to 
Impaticized content should point to a common codebase for the player 
files. 

10.11 Converting Unsupported Elements to Pictures 
This release of Impatica for PowerPoint supports most of the text and 
graphics formats and features that are supported by PowerPoint.  There 
are, however, a few formats and features that are not currently supported 
such as 3D effects, certain text and shape attributes and some graphic 
formats.  In most cases, these unsupported formats can still be used within 
your Impaticized presentation with only a modest amount of additional 
effort. 

All you have to do is to convert the unsupported element to a picture prior 
to conversion. 

Caution:  Make certain that you save a copy of your PowerPoint 
presentation prior to converting unsupported objects to 
pictures.  Once the objects are converted, you will not be able to 
make any revisions to the original objects. 

Here are the steps: 

1. Click on the object to select it. 

2. From the Edit menu, choose Copy. 

3. From the Edit Menu, choose Paste Special. 

4. In the Paste Special dialog box, select Picture. 

5. Reposition the new Picture on top of the original object. 

6. Right click on the new picture to display the Shortcut Menu and 
choose Order.  Select Send to Back.  Even though the new picture in 
now “behind” the original object, it is still selected and visible. 

7. Click elsewhere on the slide to de-select the new picture. 

8. Click on the picture to select it.  This time you will select the original 
object (the one on “top”). 

9. Click Delete. 
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Repeat this process for each unsupported text or graphics format that you 
wish to incorporate in your Impaticized presentation. 

Then, translate your presentation in the normal manner. 

10.12 Experiment with Translation Settings 
Impatica for PowerPoint allows you to add the same file to the list of 
source files.  Use this feature to translate the same file with different sets 
of translation settings. Be sure, though, to specify different save names for 
each instance.  Once the translation is complete, use the Preview button 
and File Info tab to determine which set of translation settings yields the 
best results for your presentation. 
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11111111    Product Technical Specifications Product Technical Specifications Product Technical Specifications Product Technical Specifications     

11.1 Supported Software 
This version supports the following: 

� Microsoft Windows NT, 2000, and XP. 
� Microsoft PowerPoint 97, 2000 and 2002 (XP). 
 
For details on the features supported by Impatica for PowerPoint, refer to the Impatica for 
PowerPoint User’s manual (available on-line). 
 

11.2 System Requirements 
Production: 
� Pentium or equivalent 
� Windows 2000 or XP 
� 128 MB RAM 
� 50 MB available disk space 
� 1024 x 768 screen resolution 
� 16-bit color 
 
Hosting: 
� Any HTTP web server 
� No special server side software 
 
Playback 
� Any operating system with standard Java support such as Windows, Linux, Solaris, 

and MAC OS 
� Any Java enabled browser, such as Internet Explorer 3+, Netscape Navigator 3+, 

Mozilla, and Opera 4+ 
� Any of the most commonly used e-mail programs such as Outlook 2000+, Outlook 

Express 5+, Netscape Messenger, Mozilla Mail, AOL Webmail, Lotus Notes R5 and 
Eudora 4.3+ 
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